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Preface

Purpose of this Document

This manual provides additional information on the use of Interstage Application Server
Note

Throughout this manual Interstage Application Server is referred to as Interstage.

Who Should Read this Document?

This document is intended for users installing and operating Interstage Application Server.

It is assumed that readers of this manual have a basic knowledge of:
e The Internet

e Apache

Windows
e Windows NT® ,Windows® 2000 and Windows 2003™ Server

Solaris OE
e UNIX

Linux

. Linux
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Organization of this Document

This document is organized as follows:

Chapter 1 - Supported Software

This chapter describes the supported software for application development and application
execution. It also describes the client-side software products required to use client applications.

Chapter 2 - Restrictions

This chapter describes the restrictions on some Interstage functions.
Chapter 3 - Notes on Interstage Operation

This chapter provides notes about the operation of Interstage.

Functions that are not Supported by the Linux Version

The following functions are not supported by the Linux version. To use those functions, use the
Windows version or Solaris™ Operating Environment version.

Multi System (available only in the Solaris™ Operating Environment version)

Cluster System

Web Server (InfoProvider Pro)

HTML Page Editing Service

ebXML Message Service

MessageQueueDirector

MQ Communication Service

InfoDirectory

COBOL Web Subroutine

COBOL/OOCOBOL development and execution environment (available on the Windows client)

Firewall linkage function (proxy linkage and HTTP tunneling) and SSL linkage function of CORBA
applications

SMEE?2 library (The SMEES3 library is available.)

Online access management function

Performance monitoring tool (real-time monitoring function of performance information)
User authentication and access control of the Component Transaction Service

AIM linkage function
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Chapter 1

Supported Software

This chapter describes the supported software.
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Chapter 1: Supported Software

Software Products Required for Application
Development

This section describes software products required for application development.

J2EE (Exclude Security)

Table 1-1 lists the J2EE (exclude security) products required for application development.

Table 1-1 J2EE (Exclude Security) Products Required for Application Development

using databases.

Edition for Windows

No. Function Name Product Name Version
1 Development of J2EE Any of
applications (*1) Interstage Apworks (*2) V5.0 or later
Interstage Application Server Plus
Developer V5.0.1 or later
2 Development of EJB applications | SymfoWARE® Server Enterprise | V5.0 or later (*3)

Oracle8i Enterprise Edition

R8.1.5 (*3)
R8.1.6 (*3)
R8.1.7 (*3)

Oracle9i Database Enterprise
Edition

Releasel (9.0.1) (*3)

SQL Server

2000 (*3)

*1) JDK1.1 and JDK1.2 are not applicable.

*2)

*3)

If the JSP remote debug function is to be used, the version of the Servlet service must match the
version of Apworks. For this reason, use V6.0.

SymfoWARE Server Enterprise Edition or Oracle8i Enterprise Edition or Oracle9i Database
Enterprise Edition is required.

Use the JDBC driver for JDK 1.2 when you use Symfoware Server Enterprise Edition and
Symfoware Server. Moreover, the JDBC driver for JDK1.2 can use the version of JDK/JRE by 1.2
or later. Do not download it though it is described, “The JNDI class library (jndi package) and
JDBC2.0 Optional Package (javax.sql package) can be downloaded from the homepage of
Javasoft of SUN Microsystems” in JDBC driver online manual of Symfoware when the JDBC driver
for JDK1.2 is used.
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Software Products Required for Application Development

Security

Use the product since V4.0L10 when you use either Symfoware Server Enterprise Edition or
Symfoware Server when you use the Symfoware with RDB2_TCP.

When the decentralized transaction function by JTS and JTA is used, Oracle8i Enterprise Edition
R8.1.7 or Oracle 9i Database Enterprise Edition is required.

Use the Interstage JDBC Driver included while packaging the EJB Service when you use SQL
Server. Refer to the associated software manual when using it. The software manual is in the
following place.

Interstage installation folder\EJB\jdbc\fjisjdbc.txt
Interstage JDBC Driver can be used only with JDK/JRE1.3.

Install the SQL Server client tool in the execution environment of Interstage JDBC Driver when the
installation environment of the execution environment of Interstage JDBC Driver and SQL Server is
different.

Table 1-2 lists the security products required for application development.

Table 1-2 Security Products Required for Application Development

No. Function Name Product Name Version
1 SSL communication function of Systemwalker PKIMGR (*1) V1.0
CORBA Service
*1) Itis required on the server issuing certification. It is not required when you acquire certification

from Certificate issue organization.

At the time of UTF-8 certificate creation, Systemwalker PkKiMGR is required.
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Chapter 1: Supported Software

Operation / Administration

Table 1-3 lists the operation/administration products required for application development.

Table 1-3 Operation/Administration Products Required for Application Development

No. Function Name Product Name Version
1 Real-time monitoring by Systemwalker CentricMGR V5.0L20 or V5.0L30 or
performance monitoring tool and later
operation management linked to (*1)
Systemwalker
2 Automatic operation linked to Systemwalker OperationMGR V5.0L20 or V5.0L30 or
Systemwalker later
(*2)
3 Interstage Operation Tool Microsoft® Internet Explorer 5.01,5.5,0r6.0
or
Netscape® Communicator 6 Series or 7 Series
4 Real-time monitoring function of SNMP service Windows NT® 4.0
performance information by the .
Network Manager Windows® 2000
(*3)
*1) If the version level of Systemwalker CentricMGR to be linked is V5.0L20, the following functions

cannot be used:

Operation status monitoring of the EJB WorkUnit (for old version compatible environment)

Displaying information on the multi object-resident objects

Real-time monitoring of the application processing status

If the version level of Systemwalker CentricMGR is V10L10 or earlier, the following functions
cannot be used:

Monitoring of the CORBA WorkUnit operating status

Monitoring of the Servlet container unit operating status (old version Servlet service)

Real-time monitoring of the application processing status for the Implementation Repository of

the CORBA WorkUnit

Real-time monitoring of the EJB application processing status of the EJB WorkUnit (for old

version compatible environment)

Information display of EJB applications on the Light EJB container (for old version compatible

environment)

Operating status monitoring of the Light EJB container (for old version compatible

environment)
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Software Products Required for Application Development

*2) If the version level of Systemwalker OperationMGR to be linked is V5.0L20, the EJB WorkUnit (for
old version compatible environment) cannot be operated automatically.

The following functions also cannot be used if the version level of Systemwalker OperationMGR is
V10.0L10 or earlier.

—  Automatic operation of the CORBA WorkUnit

—  Automatic operation of the Light EJB container WorkUnit (for old version compatible
environment)

*3) The SNMP Service is a function provided by the operating system.

Framework

Table 1-4 lists the framework products required for application development.

Table 1-4 Framework Products Required for Application Development

No. Function Name Product Name Version
1 Using database linkage Oracle Database Enterprise Release1(9.0.1) or
components of the Framework Edition / Standard Edition Release2(9.2.0)
function Symfoware Server Enterprise V5.0
Edition
2 Using XML linkage function of the | Fujitsu XML Processor V5.1.1
Framework function - Fujitsu XML Library for Java
- Fujitsu XSLT Library for Java
3 Using Struts linkage function of Struts 1.1
the Framework function

Other Functions

Table 1-5 lists the products required for application development (other functions).

Table 1-5 Products Required for Application Development (Other Functions)

No. Function Name Product Name Version
1 Development of applications of Interstage Apworks or V6.0
the SOAP Service Interstage Application Server Plus

Developer (*1)

2 Development of applications Interstage Apworks or V6.0
using UDDI client Interstage Application Server Plus
Developer (*1)
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Chapter 1: Supported Software

No. Function Name Product Name Version

3 Use of databases Symfoware® Server Enterprise V2.0L10 or later
Edition for Windows edition
Oracle7 R7.3.4 (*2)
Oracle8 Enterprise Edition R8.0.5 (*2)
Oracle8i Enterprise Edition R8.1.5 or R8.1.6 (*2)

R8.1.7

Oracle9i Database Enterprise Releasel (9.0.1)
Edition
SQL Server 6.50r7.0

4 Development of applications Microsoft® Visual C++ 5.0, 6.0, .NET

using LDAP SDK
5 Directory service (Only when you | Netscape Enterprise Server 3.5

use Netscape Enterprise Server
as WWW server)

*1) JDK1.1 and JDK1.2 are not supported.

*2) At the time of using SynfinityCLUSTER, it is required Symfoware Server Enterprise Edition V2.0L10
or later.

At the time of using JTS or JTA, Oracle Database Enterprise Edition R8.1.7, R9.0.1 or R9.2.0 is
required.
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Software Products Required for Application Execution

Software Products Required for Application

Execution

This section describes software products required for application execution.

J2EE (Exclude Security)

Table 1-6 lists the J2EE (exclude security) products required for application execution.

Table 1-6 J2EE (Exclude Security) Products Required for Application Execution

No. Function Name Product Name Version
1 Employment of the application which Oracle8i Enterprise Edition R8.1.5 (*1) (*2)
uses a database . . "
Oracle8i Enterprise Edition R8.1.6 (*1) (*2)
R8.1.7 (*1) (*2)
Oracle 9i Database Enterprise | Releasel (9.0.1)
Edition (*1) (*2)
SQL Server 6.50r 7.0 (*1)
2 J2EE Management Tool Microsoft Internet Explorer® 5.01,5.5,6.0
Netscape® Communicator 4.7 type (*3)
3 Old version Servlet Service (Only Microsoft Internet Information 4.0
when Microsoft Internet Information Server 5.0 (*4)
Server or Microsoft Internet Microsoft Internet Information
Information Services is used as the Services
Web server)

*1) Oracle8i Enterprise Edition or Oracle9i Database Enterprise Edition or SQL Server is required.

*2)

When the decentralized transaction function by JTS and JTA is used, Oracle8i Enterprise Edition
R8.1.7 or Oracle9i Database Enterprise Edition is essential.

Use Interstage JDBC Driver included while packaging the EJB Service when you use SQL Server.
Refer to the associated software manual when using it. The software manual is in the following

place.

Interstage installation folder\EJB\jdbc\fjisjdbc.txt
Interstage JDBC Driver can be used only with JDK/JRE1.3.

Install the SQL Server client tool in the execution environment of Interstage JDBC Driver when the
installation environment of the execution environment of Interstage JDBC Driver and SQL Server is
different.

When JDBC2.X of Oracle8i Enterprise Edition R8.1.6 or R8.17 or Oracle9i Database Enterprise
Edition is used, download File System Service Provider 1.2 from the JavaSoft
site(http://www.javasoft.com/). The file name as of June 8, 2001 is fscontextl 2beta3.zip, however
note that this may be changed without notice. When the downloaded files are decompressed, the
following files are restored:
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Chapter 1: Supported Software

—  providerutil.jar
—  fscontext.jar
*3) If Netscape 4.7 type is used, a screen display error may occur.

*4) Microsoft Internet Information Services 6.0 or later cannot be used.

Security

Table 1-7 lists the security products required for application execution.

Table 1-7 Security Products Required for Application Execution

No. Function Name Product Name Version

1 SSL communication function of Systemwalker PKIMGR (*1) V1.0
Web Server, CORBA Service,
Portable-ORB and J2EE.

*1) Itis required on the server issuing certification. It is not required when you acquire certification
from Certificate issue organization.

At the time of UTF-8 certificate creation, Systemwalker PkKiMGR is required.

Operation / Administration

Table 1-8 lists the operation/administration products required for application execution.

Table 1-8 Operation/Administration Products Required for Application Execution

No. Function Name Product Name Version
1 Real-time monitoring by Systemwalker CentricMGR V5.0L20 or V5.0L30 or
performance monitoring tool and later
operation management linked to (*1)
Systemwalker
2 Automatic operation linked to Systemwalker OperationMGR V5.0L20 or V5.0L30 or
Systemwalker later
(*2)
3 Interstage Operation Tool Microsoft® Internet Explorer 5.01,5.5,0r6.0
or

Netscape® Communicator 6 Series or 7 Series

4 Real-time monitoring function of SNMP service Windows NT® 4.0

performance information by the .

Network Manager Windows® 2000
(*3)
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Software Products Required for Application Execution

*1)

*2)

*3)

If the version level of Systemwalker CentricMGR to be linked is V5.0L20, the following functions
cannot be used:

—  Operation status monitoring of the EJB WorkUnit (for old version compatible environment)
— Displaying information on the multi object-resident objects
— Real-time monitoring of the application processing status

If the version level of Systemwalker CentricMGR is V10L10 or earlier, the following functions
cannot be used:

—  Monitoring of the CORBA WorkUnit operating status
—  Monitoring of the Servlet container unit operating status (old version Servlet service)

— Real-time monitoring of the application processing status for the Implementation Repository of
the CORBA WorkUnit

— Real-time monitoring of the EJB application processing status of the EJB WorkUnit (for old
version compatible environment)

— Information display of EJB applications on the Light EJB container (for old version compatible
environment)

—  Operating status monitoring of the Light EJB container (for old version compatible
environment)

If the version level of Systemwalker OperationMGR to be linked is V5.0L20, the EJB WorkUnit (for
old version compatible environment) cannot be operated automatically.

The following functions also cannot be used if the version level of Systemwalker OperationMGR is
V10.0L10 or earlier.

—  Automatic operation of the CORBA WorkUnit

— Automatic operation of the Light EJB container WorkUnit (for old version compatible
environment)

The SNMP Service is a function provided by the operating system.
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Framework

Table 1-9 lists the framework products required for application execution.

Table 1-9 Framework Products Required for Application Execution

No. Function Name Product Name Version
1 Using database linkage Oracle Database Enterprise Releasel1(9.0.1), or
components of the framework Edition / Standard Edition Release2(9.2.0)
function Symfoware Server Enterprise V5.0
Edition
2 Using XML linkage function of the | Fujitsu XML Processor V5.1.1
framework function - Fujitsu XML Library for Java
- Fujitsu XSLT Library for Java
3 Using Struts linkage function of Struts 1.1
the framework function
Portal Component
Table 1-10 lists the Portal component products required for application execution.
Table 1-10 Portal Component Products Required for Application Execution
No Function Name Product Name Version
1 Directory server (*1) InfoDirectory The LDAP system
enclosed by Interstage
Application Server V6.0
orVv1.2L10
Netscape Directory Server Ver.3.11 (supported only
by Windows NT®)
2 Web Server Interstage HTTP Server V6.0
Microsoft Internet Information Server | 4.0/5.0
3 RDBMS for repository (*2) Oracle8i Enterprise Edition R8.1.6/R8.1.7
Oracle9i database enterprise edition | Release1(9.0.1)
Release2(9.0.2)
4 Web browser(Administrative | Microsoft Internet Explorer 5.5/6.0
Console)
5 Web browser(User Page) Microsoft Internet Explorer 5.0/5.01/5.5/6.0
Netscape Navigator 4.6/4.7

*1) To use LDAP as an authentication system, it is necessary to install an LDAP system and to register
its users. For more details, refer to the manual for your LDAP product.
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*2) ltis possible to change the repository (Fujitsu Enabler) of the Portal component installed by default
to RDB by using the repository change command immediately after installation. For more details,
refer to the Portalworks Administration Guide.

Other Functions

Table 1-11 lists the products required for application execution (other functions).

Table 1-11 Products Required for Application Execution (Other Functions)

No. Function Name Product Name Version
1 Directory Service (Only when Netscape Enterprise Server 35
Netscape Enterprise Server is the
WWW server)
2 Use of Databases Symfoware Server Enterprise | V1.2L11 or later
(Excluding EJB application) Edition
Oracle? R7.3.4
Oracle8 Enterprise Edition R8.0.5
Oracle8i Enterprise Edition R8.1.5
Oracle8i Enterprise Edition R8.1.6
R8.1.7
Oracle 9i Database Enterprise | Releasel (9.0.1)
Edition
SQL Server 6.50r7.0
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Client-side Software Products Required to Use Client
Applications

This section describes the client-side software products required to use client applications.

J2EE (Exclude Security)

Table 1-12 lists the J2EE (Exclude Security) client-side software products required to use client
applications.

Table 1-12 J2EE (Exclude Security) Client-side Software Required to Use Client Applications

No Function Name Product Name Version
1 Java application of EJB Service Interstage Apworks Server V5.0 or later
(including Java applet) Runtime Package (*1)
2 Java applet of EJB Service (*2) (*3) Netscape Communicator 4.06, 4.07, 4.08, 4.5,
4.51,4.6,4.7,4.72,
4.73 or 4.75
Microsoft Internet Explorer 4.01,5.0,5.010r5.5
(*4)
3 Operation of J2EE application clients Interstage Apworks Server V5.0 or later
using JNDI, JMS, JavaMail. Runtime Package (*5)
*1) This product is required when a Java application (including a Java applet) of the EJB service is
created.
*2) To operate Java applets, the following formats are available:
—  Format to download the Portable-ORB and EJB Service client from the WWW server:
The jar file (ficontainer32_plugin.jar) for the Portable-ORB and the client of the EJB Service
must first be installed (resource must be stored) in the WWW server.
The JBK plugin provided by "J Business Kit," a component of Apworks V6.0L10, is required.
The Apworks download installer must be installed in advance.
—  Format to install the CORBA Service client and EJB Service client:
The CORBA Service client and EJB Service client must first be installed in the client.
If installation is performed without selecting JBK in custom installation mode, the JBK plugin
must be installed in advance.
*3) As the Web browser, either Netscape Communicator or Microsoft Internet Explorer is required.
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*4) Service Pack 1 or Service Pack 2 is necessary for Microsoft Internet Explorer 4.01. Also, Software

*5) JDK1.1 and JDK1.2 are not supported.

Security

Development Kit for Java V4.0 is necessary for creating cab files used in Microsoft Internet
Explorer.

Table 1-13 lists the security client-side software products required to use client applications.

Table 1-13 Security Client-side Software Required to Use Client Applications

No Function Name Product Name Version
1 Encrypted communication with 128bit Netscape Communicator 4.7
Microsoft Internet Explorer 5.01
and high reliability pack
(128bit)
Framework

Table 1-14 lists the framework client-side software products required to use client applications.

Table 1-14 Framework Client-side Software Required to Use Client Applications

Framework function

Plus V6.0

Interstage Application Server
Plus Developer V6.0

No Function Name Product Name Version
1 Client (Windows®) for the web Microsoft Internet Explorer 5.x or 6.0
application using Framework Netscape Communicator 4.7X
2 Client (Macintosh®) for the web Microsoft Internet Explorer 5.1 for Mac (0S8.1
application using Framework 9.x) or
5.2 for Mac (OS X)
Netscape 7.1 (Mac OS X)
Safari 1.0
3 Using Applet linkage function of the Interstage Application Server |-

Java Plug-in

131,141,142
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Other Functions

Table 1-15 lists the client-side software products required to use client applications (other functions).

Table 1-15 Client-side Software Required to Use Client Applications (Other Functions)

No Function Name Product Name Version

1 WWW Server Linkage Netscape Communicator 4.0, 4.01, 4.02, 4.03,
4.04, 4.05, 4.06, 4.07,
4.08, 4.5, 4.51, 4.6 or

4.7
Microsoft Internet Explorer 4.0,5.0, 5.010r55
(*1)
2 SOAP Service client INTERSTAGE APWORKS V4.1 or later
Client Runtime package
Interstage Apworks Client V5.0

Runtime Package

INTERSTAGE Java Server V4.1 or later
package (*2)

Interstage Java Server V5.0 or later
package (*3)
JCE (Java Cryptography 1.2.2
Extension) (*4)
3 Using the UDDI client INTERSTAGE APWORKS V5.0
Client Runtime package (*5)
4 Using the InfoDirectory web connector | Netscape Navigator 4.7,4.73,4.75
Netscape Communicator 4.7,4.72,4.73, 4.75,
4.76,4.78
Netscape 6.0,6.1, 6.2

Microsoft Internet Explorer 5.01,5.5,6.0

*1) Service Pack 1 or Service Pack 2 is necessary for Microsoft Internet Explorer 4.01. Also, Software
Development Kit for Java V4.0 is necessary for creating cab files used in Microsoft Internet
Explorer.

*2) Use the functions corresponding to the APWORKS Client Runtime Package in the Interstage Java
Server Package. For details of the functions corresponding to the APWORKS Client Runtime
Package in the Interstage Java Server Package, refer to Section 4.6 Download Installer in
\DATA4\READMEAP.TXT on the Interstage Java Server Package CD-ROM.

*3) When using the remote installation function of the EJB Deployment tool, the Interstage Operation
Tool needs to be installed on the server for installation.

*4) Required when password management function for client authentication of SSL communication of
SOAP Service client side is used.

*5) JDK1.1 and JDK1.2 are not supported.
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Chapter 2

Restrictions

Some functions described in this manual have restrictions. The following tables detail these restrictions.
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Restrictions on Interstage HTTP Server

Table 2-1 Restrictions on Interstage HTTP Server

No. Restriction Remarks Date of
Removal
1 When a certificate in UTF-8 format, None Not
(such as a CA certificate, site certificate, determined

or client certificate) is used for SSL
communication, the following restrictions

apply:

- When SSL protocol Version 3 (client
certificate) is used, the CA certificate
and the client certificate in UTF-8 must
be registered on both the Interstage
HTTP Server and the web browser.

- When SSL protocol Version 2 (server
authentication) is used, the CA
certificate and the client certificate in
UTF-8 must be registered on both the
Interstage HTTP Server and the web
browser.

- If Interstage HTTP Server is started in
either of the above SSL versions, normal
access is available only via Internet
Explorer 5.5 or 6.0 on Windows® 2000.
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Restrictions on InfoProvider Pro

Table 2-2 Restrictions on InfoProvider Pro

or client certificate) is used for SSL

communication, the following restrictions

apply:

- When SSL protocol Version 3 (client
certificate) is used, the CA certificate
and the client certificate in UTF-8 must
be registered on both InfoProvider Pro
and the web browser.

- When SSL protocol Version 2 (server
authentication) is used, the CA
certificate and the client certificate in
UTF-8 must be registered on both
InfoProvider Pro and the web browser.

- If InfoProvider Pro is started in either
of the above SSL versions, normal
access is available only via Internet
Explorer 5.5 or 6.0 on Windows® 2000.

No. Restriction Remarks Date of
Removal
1 When a certificate in UTF-8 format, None Not
(such as a CA certificate, site certificate determined
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Restrictions on the J2EE Service

Table 2-3 Restrictions on the J2EE Service

No. Restriction Remarks Date of
Removal

1 If the EAR file is opened using the J2EE | None. Not
Deployment tool and the Application ' determined
Display Name of the application is gge|glisdcg,ne2?fstﬁ\éeda?er not
changed, some contents such as class disp Iay ed y
files may not be displayed in the played.

General contents of the Web
application.

2 When the J2EE Deployment tool is Select the Cancel button. Not
used, a save confirmation dialog box determined
appears before closing a file. If the
Close button on the title bar of the
window is used, or if Close is selected
from the window menu, the operation is
the same as if No was selected. (Note
that the operation in this case is not the
same as if Cancel was selected!)

3 When the J2EE Deployment tool is used | None. Not
with JDK/JREL.3, the details of the file determined
cannot be displayed on the File
selection or Directory selection screen.

4 The remote installation function of the Transfer the server distribution Not
EJB Deployment tool cannot be used if generated with the EJB determined
the installation destination machine is a Deployment tool to the operation
cluster system. destination machine and install it

with the ejbinstalleb command.
For details on the ejbinstalleb
command, see Chapter 5
ejbinstalleb in the Reference
Manual (Command Edition).

5 It is not possible to access the database | When the global transaction is Not
directly from a J2EE application client used with the JTA interface, be determined
and a Web application while using the sure to access the database from
global transaction with the JTA interface. | an EJB application.

6 Interstage cannot be stopped forcibly Stop the J2EE Deployment tool Not
(the isstop command cannot be and then forcibly stop Interstage determined
executed by specifying option -f) with (execute the isstop command by
the J2EE Deployment tool activated. specifying option -f).
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Restrictions on the Servlet Service

Table 2-4 Restrictions on the Servlet Service

No.

Restriction

Remarks

Date of
Removal

When Apworks is used for remote debugging, the
following may occur:

When a Servlet service or servlet container is
stopped, the following message is output to standard
output or the standard input-output log file of the
servlet container:

"Internal debug-agent exception"

Ignore this message.

Not
determined

The following phenomenon may occur when
performing a remote debug using Apworks:

- The Servlet service may end abnormally if
JDK1.3(Java 2 Classic VM, JPDA) is used and the
debug of Apworks is started before the Servlet
service is started.

Start the debug of
Apworks after
starting the Servlet
service.

Not
determined
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Restrictions on the EJB Service

Table 2-5 Restrictions on the EJB Service

are called from some particular methods, an
lllegalStateException will be thrown.

- getCallerldentity()

- getCallerPrincipal()

- isCallerInRole(Identity role)

- isCallerInRole(String roleName)

If any of the above methods are called from one of the
following methods, an exception will be thrown.

- For STATEFUL Session Bean
beforeCompletion
afterCompletion

- For Entity Bean
ejbStore

No. Restriction Remarks Date of
Removal
1 The long type data type cannot be used as an argument | None Not
or return value for the client/server communication. determined
2 In JDK/JRE 1.2.2, any class in which String data of 64 None Not
KB or more is set to one variable in the class cannot be determined
used as an argument or return value for EJB
applications.
3 In the client/server communication in JDK/JRE1.2.2, None Not
when the interface shown below is used in business determined
method parameters and return value, the method for the
stored interface type cannot be issued. This is the case,
even if the interface type that can be communicated in
the application execution by the RMI over IIOP was
stored in that interface.
- java.util.Collection
- java.util. Enumeration
4 When defining a Bean in the Rapid invoking Bean, if it None Not
uses JDK/JREL1.2.2, the return value cannot use the determined
finder method of java.util. Enumeration or
java.util.Collection.
5 Using "remove" as a business method name may lead None Not
to unexpected results. determined
6 When distributed transactions are used, if any of the None Not
following methods from the javax.ejb.EJBContext API determined
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thrown.

No. Restriction Remarks Date of
Removal
7 If any of the above methods are called from one of the None Not
following methods, an exception will be thrown. determined
- getCallerldentity()
- getCallerPrincipal()
- isCallerInRole(Identity role)
- isCallerInRole(String roleName)
If any of the above methods are called from one of the
following methods, an exception will be thrown.
- For STATEFUL Session Bean
ejpbRemove
8 In the following cases, invoking a method that has None Not
method permission setting from an EJB application determined
method, a RemoteException is thrown.
- When the distributed transaction function is used
[STATEFUL Session Bean]
beforeCompletion
[Entity Bean]
ejbStore
- When the Session Timeout function is used
[STATEFUL Session Bean]
ejbRemove
9 If "Application” is specified in the resource connector of | None Not
the deployment descriptor file, and a JDBC resource is determined
being accessed from an EJB application method, an
SQLException is thrown in the following cases.
- When the distributed transaction function is used
[STATEFUL Session Bean]
beforeCompletion
[Entity Bean]
ejbStore
- When the Session Timeout function is used
[STATEFUL Session Bean]
ejbRemove
10 If "Application" is specified in the resource connector of | None Not
the deployment descriptor file, and a JDBC resource is determined
being accessed from an EJB application method, an
SQLEXxception is thrown in some cases.
11 If distributed transactions are used and the Snap output | None Not
level is set to "2", an ORA-01002 error in Oracle may be determined
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No. Restriction Remarks Date of
Removal

12 Currently (May 2002), no database supports JDK1.4, None. Not
and therefore, no database can be accessed from EJB determined
when JDK1.4 is used.

13 When the user snap function is used with JDK1.4, the None. Not
log information of the product in which the determined
java.util.Logging package is installed may be output to
the EJB snap file.

14 The EJB application that implements both Local and Calling of an Not
Remote interfaces cannot be used. It becomes an error | Entity Bean determined
at the startup when it is used. outside the

process is not
recommended.
Therefore, use
the Local
interface instead.

15 CDATA section cannot be described in deployment None. Not
descriptor. CDATA section will be deleted when it is determined
described and then executed the deployment.

16 Distributed Transaction in CMP2.0 cannot be used. It None. Not
causes EJB1248 error at the startup when it is used. determined

17 When the following API of javax.ejb.SessionContext is None. Not
executed in a specific method of EJB application that determined

implements the Local interface, it returns Null.
[getEJBLocalObject]

When this method is executed, the following method
returns Null.

[In case of STATEFUL Session Bean or STATELESS
Session Bean]

- ejbCreate
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No.

Restriction

Remarks

Date of
Removal

18

In a specific method of the EJB application that
implements both Local and Remote interfaces, the
following API of javax.ejb.SessionContext or
javax.ejb.EntityContext is executed, it returns Null.

[getEJBLocalObject]

When this method is executed, the following methods
return Null.

[In case of STATEFUL Session Bean]
- ejbCreate

- afterBegin

- beforeCompletion

- afterCompletion

- bisiness method

- ejbRemove

[In case of STATELESS Session Bean]
- ejbCreate

- bisiness method

- ejpbRemove

[In case of CMP2.0 Entity Bean]

- ejpbRemove

None.

Not
determined

19

In a specific method of the EJB application that
implements both Local and Remote interfaces, when the
getEJBHome method is issued to the EJB object got by
getEJBObject of SessionContext, it returns
RemoteException. When the above method is
executed, the following methods cause an exception.

[In case of STATELESS Session Bean]
- ejbCreate

- ejbRemove

None.

Not
determined

20

When the lookup via Remote interface is done in the
EJB application that implements both Local and Remote
interfaces from the same EJB application,
java.lang.ClassCastException occurs.

See Note 1 below

Not
determined

Note 1

When the lookup via LocalHome and Home interface is done in the EJB application that implements
both Local and Remote interfaces from the same EJB application, the following works are necessary for
the EJB application development and its runtime operation.
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[EJB application development]
1. Deployment Edit descriptor

Edit not to duplicate EnterpriseBean reference name for “ejb-ref-name” in the “reference EJB tag”
or‘reference LocalEJB tag”.

2. Development of EJB applicationDescribe not to duplicate the EJB application name specified for
the argument at lookup via LocalHome interface and via Home interface. Describe EJB application
name corresponding to the reference EnterpriseBean name defined in reference EJB or reference
LocalEJB set by 1.

[Runtime of EJB application]

Associate it with the EJB application name specified by the argument at lookup in the reference
LastName of EnterpriseBean changed by 1 and the EJB application by using the Naming Conversion
file.
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Restrictions on the SOAP Service

The SOAP Service can be used with the following products:

Table 2-6 Restrictions on the SOAP Service

Interstage Application Server Plus

Interstage Application Server Enterprise Edition

Interstage Application Server Standard Edition

No. Restriction Remarks Date of
Removal

1 The Web service information edit Use two WWW servers for Web Not
tool cannot edit Web service service information management and | determined
information for a server if execution Web service server application
of client authentication in SSL operation.
communication is set for the server. Set SSL communication without
To use the Web service information client authentication for the WWW
edit tool when a Web service server server for Web service information
application is operated with client management.
authentication specified for SSL .
communication, the operation Opel_rati:_ a Sotﬁp §ef"!"f Vgleb
explained in the Remarks column is appiication with administrator
necessary. _authorlty given to the Web service

information edit tool and Web service
manager in this WWW server.

Set SSL communication with client
authentication for the WWW server
for Web service server application
operation.

Operate a SOAP Service Web
application with administrator
authority given to the Web service
manager in this server and connect a
Web service client to this server. For
the Web service manager, set
reference to the same Web service
information management file as the
file for Web information
management.

2 If a message with attachment is sent | None Not
using the delivery guarantee determined
function, the saved attachment data
of the message may be lost and no
attachment may be found in the sent
message.
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No.

Restriction

Remarks

Date of
Removal

When this occurs, the following
message will be output:

UX: ISSOAP: ERROR: issoap1563:
Method invoke error :
java.io.lOException:
java.io.FileNotFoundException:
Ivaritmp/Soapx17284soapx

If a SOAP Message object is built in
a stream including attachment data
and shared with multiple requests in
the SOAP server application, the
following problems occur in the
subsequent request processing:

- An exception occurs when the
attachment of the SOAP Message
object is obtained and executed.

- If the SOAP Message object is
returned as a return message, the
same message as that for the Item 2
above is output and a return
message with no attachment data is
sent back.

None

Not
determined

The user authentication function for
SOAP Message cannot be used.

None

Not
determined
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Restrictions on the CORBA Service

This section provides information on the restrictions on the CORBA Service.

Restrictions on IDL Definitions

The IDL definitions can be used with the following products:

Interstage Application Server Enterprise Edition
Interstage Application Server Standard Edition

Interstage Application Server Plus

Table 2-7 Restrictions on IDL Definitions

- Size of the string type (stinrg/wstinrg) with
the specified size

- Size of the sequence type (sequence)

- Number of elements of the enumeration
type (enum), structure (struct), union (union),
and exception structure (exception)

(See Note)

- Size of an array

No Restriction Alternative Method Date of
Removal
1 Type wchar, wstring cannot be used in the None Not
const declaration of the IDL definition determined
2 The following values cannot exceed 65535 in | None Not
the data type declaration. determined
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No

Restriction

Alternative Method

Date of
Removal

Preprocessing declarations cannot be used
under the following conditions:

1) In an exception declaration

2) In a struct/union/enum declaration, and in
a member declaration (ending before a
semicolon)

Example:
struct STR1{
long
#pragma version STR1 2.3
a,
string b;
char c;

h

None

Not
determined

The following recursive declarations cannot
be used in the Java mapping of the IDL
definition:

1) Recursive declaration of a structure
(struct)

struct STR1 {
sequence<STR1> paral,

2
2) Recursive declaration of a union (union)

union UNI1 switch(long){
casel: sequence<UNI1> paral;

3

None

Not
determined

Type union cannot be used in the
CORBA/SOAP gateway generation of the
IDL definition.

None

Not
determined
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specified in the following declarations. When
the same name is specified, a package
name will become a module name +
‘Package’, and a Java compile error will
occur.

1) interface declaration
2) struct declaration
3) union declaration
4) exception declaration
Example
module AAA {
interface AAA {
short op();
h
h

No Restriction Alternative Method Date of
Removal
6 In the Java mapping of the IDL definition, the | None Not
same name as the module name cannot be determined
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No Restriction Alternative Method Date of
Removal
7 When registering an updated IDL definition When creating IDL definition | Not
containing inheritance of two or more files to be registered in an determined
interface declarations in an interface interface repository, do not
repository, the inheritance cannot be create the same interface
registered in the repository under the declaration in different IDL
following conditions: definition files if two or more
1) Another IDL definition file is included in g‘;ﬁgﬁgﬁtggc'mm'ons are to
the IDL definition, and ’
2) The interface declaration in the included Example:
IDL definition file is inherited in two or more [INTF_A.idI file]
IDL definition files, and .
interface A{...}
3) The two or more IDL definition files in e
condition 2) are updated and registered in [INTF_BC.idl file]
the interface repository. #include "INTF_A.idl"
Example: interface B:A{...}
[INTF_A.idl file] interface C:A{...}
interface A{...}
[INTF_B.idl file]
#include "INTF_A.idI"
interface B:A{...}
[INTF_C.idI file]
#include "INTF_A.idI"
interface C:A{...}
8 "' cannot be specified in the constant None Not
expression in the case statement of a union. determined
Note:

The maximum numbers of elements vary in the Java mapping.

Enumeration (enum):

1,024

Structure (struct), union (union), and exception structure (exception):
254 ("long long" and "double" are each counted as 2.)
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Restrictions on IDL Compilation

The IDL compilation can be used with the following products:

e Interstage Application Server Enterprise Edition

e Interstage Application Server Standard Edition

e Interstage Application Server Plus

Table 2-8 Restrictions on IDL Compilation

No Restriction Alternative Date of
Method Removal
1 "-noinclude" cannot be specified for the IDL compiler. None Not
determined
2 A prototype module definition file with no PROGRAM-ID None Not
named IDL-file-name_skel.def may be created in the determined
COBOL mapping of IDL files.
3 Long long overflows are not checked when IDL is None Not
compiled determined
Restrictions on C and C++ Programming
C and C++ Programming can be used with the following products:
e Interstage Application Server Enterprise Edition
e Interstage Application Server Standard Edition
Table 2-9 Restrictions on C and C++ Programming
No. Restriction Alternative Date of
Method Removal
1 Solaris OE Use _exit() Not
) ) when you finish | determined
When a child process is generated by a server a child process
application, and the child process is terminated by exit(), only.
the parent process is also terminated.
2 Solaris OE None Not
) ) determined
If WS Compilers C++ 6 used, no context object can be
used.
3 Linux None Not
o determined
A context cannot be used on the C++ application.
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Restrictions on Java Programming

Java programming can be used with the following products:

Interstage Application Server Enterprise Edition
Interstage Application Server Standard Edition

Interstage Application Server Plus

Table 2-10 Restrictions on Java Programming

No. Restriction Alternative Date of
Method Removal
1 The data type of the long long cannot be used in None Not
preinstalled type Java client and the Java server of determined
JDK/JRE 1.2.2 and 1.3
2 In Java, when the equal method is executed with None Not
TypeCode of a structural type that contains the Object determined
type, TypeCode remotely generated and the same
TypeCode generated locally do not match.
3 Solaris 0E  Linux None Not
. determined
The green thread of HotSpot VM and Classic VM cannot
be used as Java application execution environment.
Restrictions on the Naming Service
Table 2-11 Restrictions on the Naming Service
No. Restriction Alternative Date of
Method Removal
1 Solaris OF None Next version

No IP address in the IPv6 format may be specified in
inithost(nshost) of a corbaloc URL schema.
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Restrictions on the CORBA Service

Table 2-12 Restrictions on the CORBA Service

No. Restriction Alternative Date of
Method Removal
1 Windows Use the netstat | Not
) -a command to determined
The system may not release the CORBA Service port check that the
number (eg, 8002) when the isstop command is run. CORBA Service
When the OD_start service was started (including port number
execution of the isstart command) in this status, it is has been
possible that a communication error occurs in the released then
application. start the
service.
2 Windows Terminate all Not
CORBA determined
If the OD_start service is terminated before a CORBA applications
application is terminated, the system may stop before
responding or "hang" while the CORBA application is terminating the
terminated. OD start
service.

3 When the server per method is used for starting a None Not
CORBA application, starting the CORBA application may determined
fail.

4 Windows It is necessary Not

to stop and determined
In Windows NT® Server with Service Pack 5, when restart the
simultaneous requests are issued by a client that has CORBA
generated multiple threads and a communication error Service.
(COMM_FAILURE exception) occurs, the system
resources used by the CORBA Service may not be
released.
This will show up as repeated communication errors,
followed by all requests from client applications causing
communication errors.

5 When the dynamic skeleton interface of C++ language is None Not
used with the server application, memory leak occurs. determined
(Approximately 150 bytes for a request)

6 The odlistproc process may output the message 0d10727 | None Not
while quitting the CORBA service (ObjectDirector). . determined

No operation
problems other
than output
messages
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Restrictions on the Event Service

The Event Service can be used with the following products:

Interstage Application Server Enterprise Edition
Interstage Application Server Standard Edition

Interstage Application Server Plus

Table 2-13 Restrictions on the Event Service

No. Restriction Remarks Date of
Removal
1 The following functions cannot be used in the None Not
dynamically generated event channels. determined

- Non-volatilization of connection information and
event data

- Transaction linkage

- Channel-to-channel linkage

Windows Solaris OE
- Point-To-Point Messaging Model
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Restrictions on the Component Transaction Service

The Component Transaction Service be used with the following products:

Interstage Application Server Enterprise Edition
Interstage Application Server Standard Edition

Interstage Application Server Plus

Table 2-14 Restrictions on the Component Transaction Service

If the tdc command is executed before OD has
been started, the following message is displayed

("/tmp/aaa" and "1.0" is variable):

"tmp/aaa", line 1:

CORBA_ORSB _init Error

tdc: Stop. IDLparser status = 4
IDLdestroy_rep (I/R)
:CORBA_ORB _init
:IDL:CORBA/StExcep/UNKNOWN:1.0

command.

No. Restriction Remarks Date of
Removal
1 Windows® Solaris OE None Not
determined
If Interstage is initialized in succession using the
Interstage operation tool or the isinit command,
the initialization of Interstage may fail.
2 Windows Solaris OF Set the installation path Not
of Interstage to no more | determined
When the Component Transaction Service is than 230 bytes
used, the start of Interstage and the start of the
WorkUnit may become unusual if the installation
path of Interstage exceeds 230 bytes.
3 Solaris OE Start OD, then re- Not
execute the tdc determined
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Restrictions on the Database Linkage Service

The Database Linkage Service can be used with the following products:
e Interstage Application Server Enterprise Edition

e Interstage Application Server Plus.

Restrictions on the Locale of Languages

Table 2-15 Restrictions on the Locale of Languages

No. Restriction Remarks Date of
Removal
1 The client is not returned correctly when UNICODE Specify NONE in Not
is specified in locale when Java server applications locale when determined
are registered in the implementation repository and registering in the
the following exceptions are caused: implementation
repository

org.omg.CORBA.TRANSACTION_ROLLEDBACK
org.omg.CORBA.TRANSACTION_REQUIRED

org.omg.CORBA.TRANSACTION_INVALID_
TRANSACTION
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Restrictions on InfoDirectory

Restrictions on the InfoDirectory Administration Tool

Table 2-16 Restrictions on the InfoDirectory Administration Tool

No. Restriction Remarks Date of
Removal
1 Multiple management tool clients None. Not
cannot simultaneously access the Ensure that. when a management determined
same directory server except for ) ’ 9
tool client makes other than a
references.
reference, no other management tool
client attempts to access the same
directory server.
Restrictions on the JNDI
Table 2-17 Restrictions on the JNDI
No. Restriction Remarks Date of
Removal
1 The LDAP function of JINDI has not None. Not
been supported by JDK/JRE1.4. Use JDK/JREL3.1. determined
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Restrictions on JDK/JRE

This section describes the restrictions on JDK/JRE.

Table 2-18 Restrictions on JDK/JRE

StackOverflowError cannot be caught in JDK
1.3.1 and 1.4.1. The Java VM may crash
generating core and hs_err_pid***.log or
fivm_pid***.log (*** is the process ID).

No Restriction Remarks Date of
Removal
1 Windows Adjust the menu color to | Not
the menu bar or use the | determined
in Windows XP to run a Java application or a display property setting
Java applet, the background color of menu on Windows XP.
groups is different from the background color of
the menu bar.
2 Windows To avoid this, specify Not
the following Java VM determined
In using the GUI lightweight components runtime option.
(JTextField or others) in JDK/JRE1.4.1_01, )
JDK/JRE1.3.1_06 or JDK/JRE1.2.2_014 in the -Dsun.java2d.noddraw
IME2002 environment, the language bar may =true
flicker synchronously with the caret of the
component.
3 Linux None Not
determined
If JServlet is started on HotSpot VM for
debugging, remote debugging of Apworks is
used, and the Servlet container is shut down, the
Java VM may crash generating core and
hs_err_pid***.log or fiym_pid***.log (*** is the
process ID).
4 Linux None Not
determined
If the J2EE deployment tool is started, the Java
VM may crash generating core and
hs_err_pid***.log or fiym_pid***.log (*** is the
process ID).
5 Linux None Not
determined
The service concerned may be in a hang-up state
at the time of the stop of each service that uses
JavaVM.
6 Linux None Not
determined
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Restrictions on the Portal Component

Restricti

ons on Scripts in Contents

Table 2-19 Restrictions on Scripts in Contents

No. Restriction Remarks Date of
Removal
1 External contents with a script such as If a script error occurs, Not
JavaScript, JScript, and VBScript written may not | display the script on determined
be displayed correctly with Portal component or a | another window by
script may not operate correctly when the external | pressing the button.
contents are referenced via Portal component.(*1)
2 Anchor movement within a page in the brick of If the operation in a Not
the Portal component differs from that displayed content performed determined
directly on the browser. In anchor movement in without using the Portal
the brick of the Portal component, content is component differs from
redrawn. that with the Portal
Example: <a href="top"> to the top </a> component, display the
content in a separate
window.
*1  For JavaScript and JScript, display and operation with Portal component may be impossible under

the following conditions:

Exampl:eval("document.location=" + "http://foo/bar" + query);

Exampl:setTimeout("document.location = " + "http://foo/bar" + query",2000);
Exampl:setinterval("document.location = " + "http://foo/bar" + query",1000);

A script which can be rewritten with document.write() or HTML is written.

Exampl:document.write("document.location = " + "http://foo/bar" + query");
Exampl:document.write("<IMG ");document.write("SRC='/image.gif'>");

"(" or )" is used in the rewriting target object part.
Exampl:foo(x, y).bar.href = "http://xxxxx";
Operation may not be performed correctly if the following properties are referenced in a script:

document.URL
document.domain
document.referer
location.protocol
location.host
location.hostname
location.port
location.pathname
location.hash
location.search
location.href
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A script which can be rewritten with with() is evaluated.

Exampl:with(document.F1){
target="newTarget";
acrion="action.cgi";
}
When the window name is set by window.name or self.name, control in the brick frame of the Portal
component is disabled. (When the back icon or home icon in the brick frame of the Portal
component is clicked, another window opens and displays a content.)

When a processing is designed so that JavaScript in HTML content controls the Cookie in the
remote server, the Cookie is not posted to the remote server. If the Cookie is needed in the remote
server, a problem may occur in the operation of the remote server.

If a method (such as history.back();) used to perform history operation is written in the JavaScript
called by an onLoad event, a content may be repeatedly read in endless manner. If this symptom
occurs, quit the browser and change the settings so that the relevant content is not displayed in the
brick.

Restrictions on the Alternative Logon Function

Table 2-20 Restrictions on the Alternative Logon Function
No. Restriction Remarks Date of
Removal
1 Proxy logon cannot be executed if the one-time None Not
password authentication is used for contents form determined
authentication.(*1)
2 Form authentication alternative logon cannot be Register the logon form | Not
executed under the following conditions: URL after redirection as | determined
- The logon form is displayed using the HTTP an alias.
protocol redirection function.(*2)
3 When the user uses a Netscape4.X browser, the None Not
maximum number of characters in each input determined

item on the basic authentication information
setting screen and form authentication
information setting screen is defined as follows:

a) Basic authentication information setting screen
- User name: 64 bytes
- Password: 64 bytes
- Comment: 64 bytes

b) Form authentication information setting screen

- Comment: 64 bytes
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In form authentication alternative logon, the
maximum size of post data sent from a browser is
8K bytes. If this value is exceeded, the message
below is recorded in an event log and the
alternative logon fails.

[Event log message]

Failed to save proxy logon information. The
parameter is incorrect. [too long post data]

Send post data with
length of 8K bytes or
less.

Not
determined

*1 In the one-time password authentication, a password that can be only once is created using such a
key which changes for each request as the time in PC and counter value.

*2  The HTTP protocol redirection function in this condition requests a jump to the specified URL for a
browser with response code 301 or 302 returned by the Web server for an HTTP request. The
jump destination URL is written in the location header in the response header.

Restrictions on the Load Distribution Environment

Table 2-21 Restrictions on the Load Distribution Environment

No. Restriction Remarks Date of
Removal
1 Values set in the number of logon items and None Not
duplicate logon control under access control are determined
managed for each server. These values are not
managed totally in a load distribution
environment.
Restrictions on Using Netscape 4.6/4.7
Table 2-22 Restrictions on Using Netscape 4.6/4.7
No. Restriction Remarks Date of
Removal
1 If Portalworks is used to display contents None Not
determined

containing an ilayer or layer tag usable with
contents for Netscape via a Netscape browser,
error message "Not Found" is displayed and the
contents cannot be displayed correctly.
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Restrictions on Using Web USP (List of URLs to be Excluded With
Form Authentication Inherited)

Table 2-23 Restrictions on Using Web USP
No. Restriction Remarks Date of
Removal
1 For a dynamically created logon form, the same None Not
URL as an action URL from a logon form may be determined
used for access to this logon form. If so, the
function that inherits alternative logon and
displays a new browser window does not operate.
Access from PC to Secure Site (HTTPS)
Table 2-24 Access from PC to Secure Site (HTTPS)
No. Restriction Remarks Date of
Removal
1 "Network Error -1" may be displayed if two or Reduce the number of Not
brick services displayed | determined

more secure sites (httpss) are accessed in brick
services in the same roll.

in a roll, for example by
dividing the roll.

Restrictions on Using the Brick Automatic Update Function

Table 2-25 Restrictions on Using the Brick Automatic Update Function

registered as Portalworks service (alias), the
contents may not be displayed correctly.

update] under [Brick
information] and cancel
the automatic update.

No. Restriction Remarks Date of
Removal
1 If contents consisting of two or more frames are Select [Brick automatic Not
determined
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Restrictions on Other Functions

Table 2-26 Restrictions on Other Functions

Do not uninstall the following services specified in
Interstage initialization in other than Interstage
uninstallation:

- Service supported in operating mode

- Service specified in the Interstage operating
environment definition

If these services are uninstalled, Interstage
activation and reinitialization may become
impossible

uninstalled, reinitialize
Interstage so that the
service is not a target of
initialization, and then
uninstall the package.

No. Restriction Remarks Date of
Removal
1 When "SystemWalker/CentricMGR" is installed in | None Not
the same system, the "SystemWalker console job determined
monitoring" function cannot be used.
2 Solaris OE None Not
) determined
In products from SystemWalker/CentricMGR 5.0
through 5.2, the information on the following EJP
application type is not displayed.
- Bean-managed persistence Entity
- Container-managed persistence Entity
3 Solaris OE If a service listed inthe | Not
column at left is to be determined
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Chapter 3

Notes on Interstage Operation

This chapter provides additional information on the use of Interstage Application Server.
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Common Notes for Interstage

About Netscape 6

Do not install Netscape 6 on the same system.

About the Cross-Site Scripting Problem

What is the Cross-Site Scripting Problem?

The Cross-Site Scripting problem is a security problem that occurs when the client Web Browser sends
input data based on a dynamically generated Web page back to the server. Static HTML pages and
dynamically generated Web pages not using the data input, are not affected by this problem.

This is explained in the following example:

1) The following script is an example of a script that is executed when cross scripting occurs. This
script is placed at the end of the input data form script, just before "Submit".

"<SCRIPT Language=JavaScript>alert(*'Hello") ;</SCRIPT>"

2) After the input data was sent, the dialog box with “Hello” will be displayed.

The data input was processed but so was the script. However, if the user sends the input data
directly to the reliable site there is no problem even if there are errors on the page. But when the
user sends input data through an unreliable site, and the unreliable site sends this as input data to
the reliable site then the script that is executed causes the Cross-Site Scripting problem.

Analysis of the Problem

When developing applications like CGI and Servlet that generate dynamic pages to be displayed by the
Web browser and that generate Web pages without investigating the input data, this problem needs to
be fixed.

Examples:
— Retrieved result pages
—  Those checking there is no errors in the input

— Those that register the input data in databases and display the input data through key words.

Investigation Method

Review the application programs one by one from the point of retrieving input data to that of generating
the Web pages. This can be done manually, by visual inspection of the source code, or, when reviewing
the source program is not practical, by running tests such as the one described above.
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Countermeasures
When any problem is detected, take one of the following actions.
—  Stop embedding input data into Web pages

—  Convert special characters (< > &) to (&lt; &gt; &amp;).

Security Information
Security information regarding Fujitsu products is announced in the following url.

http://software.fujitsu.com/en/security/main.html

Using the JSSE Function

When Interstage Application Server is installed, a library for the Java Secure Socket Extension (JSSE)
function is stored at the following location:

<Interstage installation folder>\J2EE\lib

The stored JSSE function library is classified into two types: one for JSSE1.0.2 and one for JSSE1.0.3.
The names of the files that are actually stored are as follows:

e ForJSSE1.0.2
— isj2ee.jar (The class for JSSE1.0.2 is stored in this jar file.)
e ForJSSE1.0.3
—  jcertjar
- jnetjar
-  jsse.jar
To use the JSSE function, these files must be set with the environment variable CLASSPATH.
When JSSE1.0.2 is to be used, ensure that isj2ee.jar is set with CLASSPATH.

When JSSE1.0.3 is to be used, set jcert.jar, jnet.jar, and jsse.jar with CLASSPATH so that these files
come before isj2ee.jar.
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Monitor Screen Colors

For the machine on which Interstage Application Server is installed, use a display monitor and driver for
which 256 colors or more can be specified as monitor screen colors.

If a value of less than 256 colors is set, the GUI program using Java cannot start. This type of display
monitor cannot be used.

Applicable Functions
J2EE common resources

e J2EE resource access definition

e J2EE development tool

InfoDirectory

e InfoDirectory management tool client

¢ InfoDirectory management tool agent environment setup
e Certificate management utility

e  SSL environment setting utility

Other

e  User-developed program
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Setting Port Numbers Used for Individual Services

When port numbers are set or changed for Interstage Application Server services, unique port numbers
must be set for all individual services including applications in the system. If services are operated with
the same port number set for different services, normal operation cannot be performed (for example, a
client may fail to access a service).

Table 3-1 lists the services and functions for which port numbers are set under Interstage Application
Server. The table also lists the locations where the port numbers are set.

Table 3-1 Services/Functions for Which Port Numbers are Set

Service Name/ Port Number Setting Location
Function Name
Interstage “Port number for Interstage management console”
Management . .
Console C:\Interstage\gui\etc\httpd.conf
- Port directive
Web server “Port number for the entire Web server (Interstage HTTP server)”
(Interstage HTTP Interstage Management Console
server) 9 9
- [Services] > [Web Server] > [Web Server Settings] tab > [Port Number]
Or
The environment definition file (httpd.conf)
- Port directive
“Port number for the virtual hosts”
Interstage Management Console
- [Services] > [Web Server] > [Virtual Hosts] > [Create a new Virtual Host] > [IP
Address] and [Port Number]
Or
Interstage Management Console
- [Services] > [Web Server] > [Virtual Hosts] > [Virtual Host Name] >
[Configuration] > [IP Address] and [Port Number]
The environment definition file (httpd.conf)
- Listen directive
Note:
Setting the Listen directive in the environment definition file (httpd.conf) invalidates
the Port directive in the environment definition file (httpd.conf).
Web server "Port number for Web server (InfoProvider Pro)"
(InfoProvider Pro) InfoProvider Pro environment definition file
- port
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Service Name/
Function Name

Port Number Setting Location

CORBA Service

"Port number for CORBA service"
Interstage Management Console

- [System] > [Update System Settings] > [CORBA Service Settings [Show]] >
[Port number]

Or
The environment definition file (config)
- IOP_port

"Port number for CORBA service SSL"
Interstage Management Console

- [System] > [Update System Settings] > [CORBA Service Settings [Show]] >
[SSL Encryption] > [SSL listen port]

Or
The environment definition file (config)
- UNO_IIOP_ssl_port

Servlet Service

"Port number for Servlet service"
Interstage Management Console

- [WorkUnits] > [Create a new WorkUnit] > [Detailed Settings[Show]] > [Servlet
Container Settings[Show]] > [Port number]

Or
Interstage Management Console

- [WorkUnits] > Select "IJServer name" > [Settings] > [Servlet Container
Settings[Show]] > [Port number]

Interstage Management Console

- [Services] > [Web Server] > [Web Server Settings] > [General Settings] >
[Port number]

Note:

Port numbers must be set when the Web server connector and Servlet container
are provided on separate systems (when "Yes" is selected from "Run Web server
and WorkUnit on the same machine?" on the [System] > [Update System
Settings] > [Detailed Settings[Show] > [Servlet Container Settings[Show]]). A port
number does not need to be set when these components are provided on the
same machine.
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Service Name/
Function Name

Port Number Setting Location

Servlet Service for
Interstage
operation control

"Port number for Interstage operation control Servlet service"
JServlet environment definition file
- [containername].port definition
Servlet gateway environment definition file
[When Web server is Interstage HTTP Server]
- ApJServMount definition
- ApJServHost definition
[When Web server is other than Interstage HTTP Server]
- Container definition
Servlet container environment definition file

- Parameter tag

Old version Servlet
Service

"Port number for old version Servlet service"
JServlet environment definition file
- [containername].port definition
Servlet gateway environment definition file
[When Web server is Interstage HTTP Server]
- ApJServMount definition
- ApJServHost definition
[When Web server is other than Interstage HTTP Server]
- Container definition
Servlet container environment definition file

- Parameter tag

Interstage JMX
Service

"Port number used for the Interstage JMX service to receive a request from the
Interstage Management Console"

Customize by specifying a value for the rmi attribute on the "port" tag in the
isimx.xml file.

"Port number required for operation of the Interstage JMX service"

Customize by specifying a value for the internal attribute on the "port" tag in the
isimx.xml file.
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Service Name/
Function Name

Port Number Setting Location

Infodirectory
Directory Service

“DSA LDAP port number”
[When DSA is created]

[Management tool client] > [InfoDirectory Server Management] > [ Create
DSA] > [Configure Processes] > [Active process] > "Select LDAP process
(mtldapd)" > [Property] > [LDAP Configuration] > [Port No]

[After DSAis created]

[Management tool client] > [InfoDirectory Server Management] > [Configure
Processes] > "Select LDAP process (mtldapd) from [Active process]" >
[Properties...] > [LDAP Configuration] > [Port No]

“Port number for shadowing (DISP)”

[Management tool client] > [Server management] > [Database] > "Select
[Configuration]" > "Select [Network parameter]" > [open] > [Addressing...] >
"Select [DISP]" > "Select [TCP/IP] from "[Network address]" > [Modify] (or [Add]) >
[Port]

“Port number of subordinate reference (DAP or DSP)”

[Management tool client] > [Server management] > [Database] > "Select
[Configuration]" > "Select [Network parameter]" > [open] > [Addressing...] >
"Select [DAP or DSP]" > "Select [TCP/IP] from "[Network address]" > [Modify] (or
[Add]) | [Port]

Windows

Windows [Start] menu | [Programs] | [Interstage] | [Application Server] |
[InfoDirectory] | [Directory service property] | [RFC1006] tab | [TCP/IP port
number]

(For [TCP/IP port number], specify the same number as that specified for the port
number for the subordinate reference.

“Web connector port number”
[When DSA is created]

[Management tool client] > [InfoDirectory Server Management] > [ Create
DSA] > [Configure Processes] > "Select [Web process] from Process column”
> "idweb selected state" > [Properties...] > [Listening port]

For [LDAP port], specify the same number as that specified for "DSA LDAP
port number."

[After DSA is created]

[Management tool client] > [InfoDirectory Server Management] > [Configure
Processes] > "Select idweb from [Active process]" > [Properties...] >
[InfoDirectory Web configuration] > [Port No]

For [LDAP port], specify the same number as that specified for "DSA LDAP
port number."
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Notes on the Interstage Operation Tool

The Interstage Operation Tool can be used with the following products:
e Interstage Application Server Enterprise Edition
e Interstage Application Server Standard Edition

e Interstage Application Server Plus

Version Level of Each Service Performing the Operation

Solaris OF
The version level of each service operating with Interstage Operation Tool is limited to the service

installed with the same CD-ROM. The service installed with the CD-ROM of other version levels cannot
be operated.
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Notes on the Interstage Integration Commands

Windows
This section provides additional information on the Interstage integration commands.
The Interstage integration commands can be used with the following products:
e Interstage Application Server Enterprise Edition
e Interstage Application Server Standard Edition

e Interstage Application Server Plus

Dealing with Abnormal Command Termination

If the isstart, isstop or isinit command terminates abnormally, terminate the system by using the —f option
in the isstop command.

To start Interstage again, use the isstart command.

Starting and Stopping Services

Do not start or stop the following services when using the isgendef, isregistdef, isinit, isstart or isstop
commands:

e OD_start

e NamingService

e InterfaceRep_Cache Service
e InterfaceRep_Cache_e Service
e EventService

e TransactionDirector

e  ObjectTransactionService

e Interstage API

e NS LoadBalancing Option

e F3FMwww

e Interstage JServlet

e CORBA_SOAP ClientGW

Note on Stopping Interstage

To stop Interstage, first stop all WorkUnits, then use the isstop command to stop Interstage.

3-10



Notes on the InfoProvider Pro

Notes on the InfoProvider Pro

Windows Solaris OE
This section provides notes on the InfoProvider Pro.
(1) Authority to Use the Web Server

Web server install/uninstall and Web Server start/stop operations can be used only by
Administrators or users with Administrator authority.

(2) SQL Gateway

Articles about the SQL gateway have been deleted from V4.0. This function can still be used in the
current version. Those who use the SQL gateway of V3.0 or earlier and require the manual should
refer to the manuals of V3.0 or earlier.

(3) When accessing from a Web browser using the IPv6 Protocol

When accessing from a Web browser using the IPv6 protocol, use an OS product and Web
browser which support the IPv6 protocol officially.
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Notes on the Interstage HTTP Server

This section provides notes on the Interstage HTTP Server.

Authority to Use the Interstage HTTP Server

Windows

Interstage HTTP Server install/uninstall and Interstage HTTP Server start/stop operations can be used
only by Administrators or users with Administrator authority.

Notes on Operating Interstage HTTP Server

Solaris OE  Linux
Do not delete the following process management files while operating Interstage HTTP Server.
/opt/FISVihs/logs/httpd.pid

If the file is deleted, the operation of Interstage HTTP Server cannot be guaranteed. Restart the system
again to operate normally.
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Notes on J2EE

1) J2EE Application Operation

To use the following XML files while the web application or the J2EE application client is operating, add
the Java VM heap area, which is calculated from the formula shown below, to the specified value for the
maximum Java VM heap area size.

e Target XML files during operating web application
—  Web application environment definition file (web.xml)
—  Name conversion file (FJWebebeProperties.xml).

e Target XML files during operating J2EE application client
—  Deployment descriptor file
—  Name conversion file.

Java VM heap area size calculation

Use the following formula to calculate the Java VM heap area size of each XML file. Add them to find the
total required area:

(((a* 460) + b) / 1024) + 500) * ¢ (unit: kilobytes)
a: Number of lines in an XML file
b: XML file size (unit: bytes)

c: Number of clients accessed at the same time (when operating the Web application), or the
number of threads that issue lookups (when operating the J2EE application client)

The specification method of Java VM heap area size
When operating the Web application

Specify the size for the JavaVM option at [WorkUnits] > "IJServer name" > [Settings] tab.>
[WorkUnit setting[Show]] > [Java VM Options] on the Interstage Management Console

Example of specifying 512 megabytes for the maximum Java VM heap area size:

-Xmx512m

When operating the J2EE application client
Use the -Xmx option of the Java command, and specify the size as shown below:

Example of specifying 128 megabytes for the maximum Java VM heap area size:

Java -Xmx128m ClientAPL
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Event resulting when the Java VM heap memory becomes insufficient

When an application is operated, if the Java VM heap area size to be used is not added to the maximum
size, the following event may occur:

javax.naming.NamingException:com.fujitsu.interstage.j2ee.def.FJDefException: unknown error:
java.lang.OutOfMemoryError
2) Use of the J2EE Management Tool or J2EE Deployment Tool

Do not use the "Release Deployment" or "Deleting IJServers" functions of the J2EE Management tool or
the J2EE Deployment tool on a Web application with the following set up:

e A Web service container of SOAP Service

If these functions are used, re-installation is required before the Web application can be used again.
Refer to the SOAP Service User's Guide for details of Web service containers.
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Notes on the Servlet Service

1) Servlet Service Execution Environment

The Servlet Service execution environment is based on Tomcat4.1.2. A Servlet or JSP application that
runs on Tomcat4.1 or later may not function correctly.

2) Execution Environment of Earlier Version Servlet Service

An earlier version Servlet Service (servlet execution environment based on tomcat3.1) is not compatible
with the Microsoft Internet Information Server of Windows 2003 Server.

When the Windows 2003 Server is used, use the Interstage Application Server Web server.

3) Session Management Cookie of Servlet Service

When the Web server runs in an SSL environment, the Secure attribute is automatically added to the
session management cookie.

If the Web server runs in non-SSL (HTTP) mode while the SSL accelerator is used, the Secure attribute
is not automatically added. Use the following method to add the Secure attribute:

[V6.0 Servlet Service]
Refer to Environment Setup for Servlet Service in Chapter 12 in the Security System Guide.
[Earlier version Servlet Service]
Modify the following JServlet properties file:
Definition file name : jservlet.properties
Storage location  : C:\Interstage\F3FMjs2\conf
Definition item : com.fujitsu.interstage.jservlet.session.cookie.secure.mode=auto|secure
— auto: Default value

When the Web server runs in an SSL environment, the Secure attribute is automatically added
to the session management cookie.

—  secure:
Be sure to add the Secure attribute to the session management cookie.

Select this option when the Web server runs in non-SSL (HTTP) mode while the SSL
accelerator is used.

Definition example: com.fujitsu.interstage.jservlet.session.cookie.secure.mode=secure
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Notes on Using the EJB Service

This section provides information on using the EJB Service.

Version of Java Development Kit/Java Runtime Environment

1)

2)

The same version of Java Development Kit (JDK)/Java Runtime Environment (JRE) is
recommended from development to execution.

The application class created by the Java Development Kit 1.1.x javac command is not always
executable in Java Development Kit/Java Runtime Environment 1.2 and 1.3 execution environment.
In this case, recompile in a Java Development Kit 1.2 or 1.3 environment before execution.

The application class created by JDK 1.2.x or 1.3.x javac command is not executable in a Java
Development Kit/Java Runtime Environment 1.1.x execution environment.

Before using the JDK/JRE1.3 environment

When using the Servlet Service in the JDK/JRE1.3 environment, do not log out of Windows. If
Windows is logged off, the Servlet container (JavaVM) terminates abnormally due to a bug in
JDK1.3 (Bug Id: 4323062). For detailed information about the JDK1.3 bugs, refer to Sun
Microsystems' Bug parade. This bug has been corrected in JDK1.3.1. For the JDK1.3.1
environment, specify -Xrs in "default.bin.parameters or [containername].bin.parameters"” of the
JServlet environment definition file.

Notes on the EJB Customize Tool

Windows

1)

2)

3)

Due to JDK/JRE restrictions, the Customize Tool display colors may be unstable or the system
cannot be started if 256 colors or less is selected for display in screen properties. Select more than
256 colors.

In addition, if the customize tool is started using Terminal Service of Windows® 2000 or
Server/Windows® 2000 Advanced Server, the number of colors that appears in the display is 256,
and the displayed colors become unstable. This does not affect the tool's operation.

When the EJB Service is installed over another edition, specify the path setting information for the
Web browser Customize Tool again after installation in order to initialize it.

EJB applications created in Interstage V2 in a JDK/JRE 1.3 or later environment cannot be
selected with the Customize Tool when it is started with the ejbcust command. Run setup again
after installation.
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4)

5)

The startup performance of the rapid invocation definition screen of the customize tool that is
started by ejbcustx is improved (V5.0). Because the processing to acquire information on
Enterprise Bean installed when it is listed is accelerated, if Enterprise Bean of the EJB1.1 and
EJB2.0 specification as well as Enterprise Bean of the EJB1.0 specification are installed in the
invoking Bean, they are also listed. If Enterprise Bean of the EJB1.0 specification is selected, an
error message appears, and the edit cannot be performed. As for V3.0, in order not to display
Enterprise Bean of the EJB1.0 specification on the rapid invocation definition screen when it is
listed, add the -v3 (or -V3) option to the ejbcustx command and execute it. However, in this case,
the processing time remains the same as that is for V3.0.

In an environment where screen response is slow (such as when using the customize tool in the
terminal service), buttons may be operated in succession during the operation of the customize tool
without visible effect. For example, it may take time to mask the button after it is pressed.

The following are specific operations where this behavior may be in evidence:
Multiple dialogs may be opened in these circumstances:

— When you select a button in the definition information (Notel) panel

—  When you select a button on the path settings screen of the WWW browser

—  When you select the Change or Add buttons to access environment definition screen
—  When you select the Delete.

—  When you select EJB Application Runtime Environment Definition in the File menu.
—  When you select Rapid invocation definition in the Tool menu.

—  When you select DB access environment definition in the Tool menu.

—  When you select Path settings of the WWW browser in the Help menu.

—  When you select Version information of the Help menu.
If multiple screens or dialogs open, close the unnecessary ones before starting the operation.

Solaris OF

1)

2)

If HotJava™ Browser is set in the “WWW Browser Path Setup” of the Customize Tool, use
HotJava™ Browser Version 3.0 or after. If a version earlier than 3.0 is used and the manual is
displayed, it may not be output normally.

The PC X Server (notel), which works on the common desktop environment (CDE) on X Server
built into Solaris™ Operating Environment OS (SPARC) by the standard or Microsoft Windows, is
necessary for the operation environment of the Customize Tool.

The response time of drawing and the operation slows in an environment that it is far from the
server, and the communication is late when executing it with the PC X server. In this case, the use
of Customize Tool of the operation command is advised.

The screen of Customize Tool might not be displayed when operating in other environments or
even if it is displayed, it might not be displayed correctly. Be sure to login on common desktop
environment (CDE) from the above environment, execute the ejbcust or ejbcustx command to
activate the Customize Tool.

Notel) These are operation results of FUJITSU PC-X V20L30 of FUJITSU Ltd. and the X Vision
Eclipse7.2 of SCO Ltd. as PC X Server product. Operation by other PC X Server products is not
guaranteed.

Set the system to use the font of the font server when using the PC X server. Refer to the Help file
appended to FUJITSU PC-X and X Vision Eclipse for details of how to set the font. In addition, it is
necessary to make font server (xfs) work on the Solaris™ Operating Environment Server side.
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3)

4)

The startup performance of the rapid invocation definition screen of the customize tool that is
started by ejbcustx is improved (V5.0). Because the processing to acquire information on
Enterprise Bean installed when it is listed is accelerated, if Enterprise Bean of the EJB1.1 and
EJB2.0 specification as well as Enterprise Bean of the EJB1.0 specification are installed in the
invoking Bean, they are also listed. If Enterprise Bean of the EJB1.0 specification is selected, an
error message appears, and the edit cannot be performed.

In the same way as for V3.0, in order not to display Enterprise Bean of the EJB1.0 specification on
the rapid invocation definition screen when it is listed, add the -v3 (or -V3) option to the ejbcustx
command and execute it. However, in this case, the processing time remains the same as that for
V3.0.

In an environment where screen response is slow (such as when using the customize tool in the
PC X Server), buttons may be operated in succession during the operation of the customize tool
without visible effect. For example, it may take time to mask the button after it is pressed.

The following are specific operations where this behavior may be in evidence:
Multiple dialogs may be opened in these circumstances:

—  When you select a button in the definition information (1) panel

—  When you select a button on the path settings screen of the WWW browser

—  When you select the Change or Add buttons to access environment definition screen
—  When you select the Delete

—  When you select EJB Application Runtime Environment Definition in the File menu

—  When you select Rapid invocation definition in the Tool menu

—  When you select DB access environment definition in the Tool menu

—  When you select Path settings of the WWW browser in the Help menu

—  When you select Version information of the Help menu
If multiple screens or dialogs open, close the unnecessary ones before starting the operation.

When Operating with WorkUnits

1)

2)

When operating EJB applications with WorkUnits, do not install the Interstage Java Server Package
and the Interstage package in a folder that includes blank spaces.

In the JDK/JRE1.3 environment, if the EJB application is operated in the WorkUnit, do not log off
from Windows NT. When this is done, the JavaVM terminates abnormally due to a JDK1.3 failure
(Bug 1d:4323062) and Interstage is forcibly stopped. For more information on JDK1.3 failures, see
the Bug Parade from Sun Microsystems.

Specify without fail =Xrs in the Java Command Option of the WorkUnit definition in case of
JDK1.3.1 environment.
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When Interstage JDBC Driver is Used

Windows

1) Data Type
The support range of the data type is as follows.

Supported Data Types

e integer type (int, smallint)

e round number type (float, real)

e character string type (char, varchar, text)

e  binary type (binary, varbinary, image)

e money type and smallmoney type

e decimal type and numeric type

e datetime type and smalldatetime type

e  Other data types (timestamp)

The timestamp type of the SQL Server is for fetching only and can be used in the BMP.

Unsupported Data Types

e integer type (tinyint, bigint)

e  bit type (bit)

e other data types (cursor, uniqueidentifier, sgl_variant, table)
e Unicode character type (nchar, nvarchar, ntext, sysname)

e  User-defined type

2) Format of the datetime Type and smalldatetime Type

When updating the data of the column of the datetime type and smalldatetime type, specify the data in
the following format.

Description Format
YYYY-MM-DD hh:mm:ss
e YYYY=year

e  MM=month

e DD=day

e  hh=hour

e  mm=minute

e ss=seconds

Note: millisecond is not supported.
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3) Stored Procedure
A stored procedure cannot be used.

4) APl when datetime Type is Used
When the following APl is used for the datetime type, only the values within the smalltime type are valid.

e PreparedStatement.setTimestamp(int parameterindex, Timestamp Xx)

5) Unsupported API
Among the JDBC API standard specifications, the following APIs are not supported.

e Connection class
—  nativeSQL(String sql)
—  setCatalog(String catalog)
— getCatalog()
e DatabaseMetaData class
— getCatalogTerm()
— isCatalogAtStart()
—  supportsCatalogsinProcedureCalls()
—  supportsCatalogsinTableDefinitions()
— getMaxCatalogNamelLength()
— getCatalogSeparator()
—  supportsCatalogsinDataManipulation()
—  supportsCatalogsInindexDefinitions()
—  supportsCatalogsinPrivilegeDefinitions()
— getTableTypes()
— getCatalogs()
— getColumnPrivileges(String catalog, String schema, String table,String columnNamePattern)
— getVersionColumns(String catalog, String schema, String table)

— getCrossReference(String primaryCatalog, String primarySchema,String primaryTable, String
foreignCatalog,String foreignSchema, String foreignTable)

— getTablePrivileges(String catalog, String schemaPattern,String tableNamePattern)
— getBestRowldentifier(String catalog, String schema,String table, int scope, boolean nullable)
— getlimportedKeys(String catalog, String schema, String table)
—  getExportedKeys(String catalog, String schema, String table)
e PreparedStatement class
—  setBoolean(int parameterindex, boolean x)

—  setByte(int parameterindex, byte x)
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— setLong(int parameterindex, long x)

—  execute()

—  setObject(int parameterindex, Object x)

—  setObject(int parameterindex, Object X, int targetSqlType)

—  setObject(int parameterindex, Object x, int targetSqlType, int scale)

—  setBigDecimal(int parameterindex, BigDecimal x)
When column data type is round number type(real type, float type)

—  setTimestamp(int parameterindex, Timestamp Xx)
When column data type is character string type(char type, varchar type)

—  setString(int parameterindex, String X)
When column data type is datetime type and smalldatetime type

ResultSetMetaData class

— getCatalogName(int column)
— getColumnLabel(int column)
Statement class

—  setEscapeProcessing(boolean enable )
— getQueryTimeout()

—  setQueryTimeout(int seconds)
— cancel()

— getMoreResults()

—  getResultSet()

— getUpdateCount()

JDBC 2.0

In the JDBC 2.0, some of the methods that were supported in JDBC1.X are positioned as ‘not
recommended methods’ and others are supported in place of them. Also, new classes and
methods are supported.

The JDBC driver supports the following methods only in place of those no longer recommended. All

other new APIs are not supported yet.

—  CallableStatement class
getBigDecimal(int parameterindex)

— ResultSet class
getBigDecimal(int columnindex)
getBigDecimal(String columnName)

—  DriverManager class
getLogWriter()
setLogWriter(PrintWriter out)
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6) Fetching aLine from a Text Type and a Table Containing an Image Type

With regard to fetching a line from a text type and a table containing an image type; in BMP, specify the
row of the text type and the image type such that they are placed last in the selected list.

—  Example 1: Specify the line of the text type and the image type so that they are placed in the
COLs3.

SELECT COL1, COL2, COL3 FROM SCM.TBL WHERE COL1="?

—  Example 2: When handling multiple lines of the text type and the image type, specify the line
of the text type and the image type so that they are placed in the COL2 and COL3 respectively.

SELECT COL1, COL2, COL3 FROM SCM.TBL WHERE COL1=?

In CMP, when operating the text type and a table containing an image type, specify the row of the text
type and the image type last in the CMF mapping definition.

Note on Class Names

When installing multiple EJB applications on the same machine, if there is a class (such as HOME
interface, Remote interface, Enterprise Bean class, and primary key class) that has the same name but
different implementation, the incorrect operation occur. Therefore, when developing EJB applications,
determine a package name so that the class name does not get duplicated.

Starting EJB Applications

In DB access environment definition of the customize tool, if the same port number of the existing
product is specified by mistake, much time is required for starting and an error occurs. Specify a correct
port number and restart.

About the EJB Application Process

Solaris OE

In the EJB application, do not control the signal by JNI (Java Native Interface). When the signal is
controlled, it does not operate correctly.
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Notes on SOAP Service

When Encryption Communication by SSL is Used

e Itis necessary to construct the SSL environment for the SOAP server and the SSL environment for
the SOAP client with the system environment that the SOAP Service operates.

e Itis necessary to construct the SSL communication environment respectively of SOAP
communication between the IIOP communication with the CORBA client application and the SOAP
server application in the CORBA/SOAP client gateway. In addition, the site certificate cannot be
shared by the [IOP communication and SOAP communication. Acquire the certificate in each SSL
communication environment.

e The certificate that the telephone number or the employee number is set for the identification name
cannot be used with the SOAP client. Set neither "Telephone number" nor "Employee number" to
the identification name when you acquire the site certificate.

When Session Recovery Function of Servlet Service is Used

When using the session recovery function of the Servlet Service, the SOAP router of the SOAP Service
cannot be employed.

When J2EE Management Tool or J2EE Deployment Tool is Used

Do not use the "Release Deployment" or "Deleting IJServers" functions of the J2EE Management tool or
the J2EE Deployment tool on a Web application of a Web service container. If these are used, re-
installation is needed in order to use the Web application of the Web service container again.
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Notes on the CORBA Service

This section provides additional information on the CORBA Service.

Notes on Installation and Environment Settings

Windows  Solaris OF
1) When the CORBA Service is installed and linked to the Systemwalker/CentricMGR operation
management tool, particular care is needed when stopping the CORBA Service and when setting
up the environment uninstalling.
Stopping
The SystemWalker/CentricMGR operation management tool cannot be used when the CORBA
Service (ObjectDirector) has been stopped
Setting Up the Environment
Setting up the CORBA Service environment may affect the SystemWalker/CentricMGR operation
management tool if it is using ObjectDirector. Pay attention to the environments for this product
when setting up the CORBA Service environment.
Uninstalling
The SystemWalker/CentricMGR operation management tool cannot be used when CORBA Service
(ObjectDirector) has been uninstalled.
Refer to Notes for Installing SystemWalker/CentricMGR in the Installation Guide for the installation
procedure.
Windows
2) When the odadmin_ex command is used to set up the environment in Windows® 2000, the

following message may be displayed, indicating that environment setup has failed:

ObjectDirector environment setup failed
Return code

2

Error details

odsetns : error occurred code = 402, 1072
Cannot execute command. : odsetns

In this case, run the process again and set up the environment correctly. If the Service property
screen is displayed, close the screen and repeat the processing.
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Notes about Setting Applications

Windows

1)

2)

When specifying environment variables in env when registering the implementation repository, do
not specify multiple character strings delimited by semicolons (;). The system recognizes
semicolons as delimiters between different environment variables.

Examples of acceptable settings:
(1) env =Path=C:\WINDOWS

(2) env = Path=C:\WINDOWS;LIB=C:\USER
Example of unacceptable setting:
(1) env =Path=C:\WINDOWS,;C:\WINDOWS\SYSTEM

If it is necessary to specify values delimited by semicolons in the PATH environment variable, do
not register the variable in the implementation repository, but use one of the following methods:

—  Set the necessary path in the PATH system environment variable

—  Set the environment variable by the application itself (putenv function)
Also note that system and user environment variables other than those specified in env are invalid.
If a server-per-method server is called continuously, increase the value in proc_conc_max.

Solaris OE

3)

To operate COBOL applications in a Shift JIS environment, specify CBR_CODE_CHECK=no.

Solaris OE

4)

If the odadmin command, isinit command or CORBA Service is executed during operation of a
CORBA application or WebGateway, the following message is output to the console.

Stop the CORBA application or WebGateway.
"UXOM 1.0:SEV=E,acf=init :demon start fails"
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Notes on the IDL Compiler

The IDL Compiler can be used with the following products:

1)

2)

3)

Interstage Application Server Enterprise Edition
Interstage Application Server Standard Edition
Interstage Application Server Plus

If the IDL compiler is used in a client, install CORBA Service Client and CORBA Service
Development Tool.

The IDL file suffix, "idl" must be in lower-case letters. If the suffix is in upper-case letters (such as
when the file is moved with ftp), change the suffix to the lower-case letters, and then execute the
IDL compile.

When the IDL compiler is used, it is necessary to set the environment variable OD_HOME.

Notes on the Java Environment

1) The applet viewer in JDK/JRE 1.2.2 and 1.3 cannot be used.
Solaris OE
2) Inthe operation of Java applet, if InfoProvider Pro is used as Web server and if cab file is written in

HTML file, file extension “cab” as data type "application/octet-stream" must be specified to the file
specified as "content-type" in InfoProvider Pro environment definition file.

Notes on SSL communication

SSL linkage cannot be used from the clients of a version of Interstage earlier than V2.0L10. Also,
the Object Reference for the SSL linkage cannot be registered to the Naming Service of Interstage
earlier than V2.0L10.

In SSL linkage, requests from the clients cannot be received in the following cases:
—  Certificates become invalid or expired after starting the CORBA Service (ObjectDirector).

— Nicknames of certificates were omitted in setting the SSL environment or in executing the
odsetSSL command.

When deleting or canceling (CRL: Registering in the list of invalid certificates) the certificates that
have been set in the CORBA Service, first terminate the CORBA Service.

When the server host names or IP addresses from the clients cannot be solved in the SSL
communication, set the server host information in the “hosts” file or DNS.
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Notes on the Event Service

The Event Service can be used with the following products:
e Interstage Application Server Enterprise Edition

e Interstage Application Server Standard Edition

e Interstage Application Server Plus

The following notes relate to the operation of the Event Service.

Note on Reinitializing Interstage

When Interstage is to be reinitialized after the event channel has been generated with the esmkchnl
command, use the esrmchnl command to delete the event channel before reinitializing Interstage. If
Interstage is to be initialized without deleting the event channel, delete the event channel that existed
before initialization, after initialization.

Notes on SSL Communication

To perform SSL communication in the event service, the SSL environment of the CORBA service must
have been set in advance.

Note on Unit Generation

Windows

To generate a unit during persistent channel operation, the storage folder of each control file must
specify a drive whose file system is NTFS. For unit generation, refer to esmkunit in the Reference
Manual (Command Edition).

Note
Persistent channel operation can be used with the following products:
e Interstage Application Server Enterprise Edition

e Interstage Application Server Standard Edition
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Note on Persistent Channel Applications

Persistent channel applications can be used with the following products:
e Interstage Application Server Enterprise Edition
e Interstage Application Server Standard Edition

If the connection is forcibly disconnected due to a system failure, applications of the persistent channel
must be restarted. If processing continues without restarting persistent channel applications, a system
exception COMM_FAILURE with the minor code 0x464a0109 (invalid data received) may be returned.

Notes on Multi-IP Address Operation

Host Name

When the host name is set to either of the following, the Multi-IP address function cannot be used:
e "Corba Host Name" in the Interstage operating environment definition file
e "lIOP_hostname" in the CORBA Service config file

Port Number

Set either of the following for the port number:

When SSL communication is invalid:

e "Corba Port Number" in the Interstage operating environment definition file
e "l[IOP_port"in the CORBA Service config file

When SSL communication is effective:

e "SSL Port Number" in the Interstage operating environment definition file

e "UNO_IIOP_ssl_port" in the CORBA Service config file

Refer to the Reference Manual (Command Edition) for the method of specifying the host name and the
port number of the Event Service.
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Notes on the Component Transaction Service

The Component Transaction Service can be used with the following products:
e Interstage Application Server Enterprise Edition

e Interstage Application Server Standard Edition

e Interstage Application Server Plus

This section provides additional information on the Component Transaction Service.

Note on Messages in Windows® 2000

Windows

If the system locale value is changed after Interstage is installed in Windows® 2000, EXTP messages
may not be displayed correctly.

About CORBA Service Termination using the isstop Command

Solaris OE

When the isstart command is executed, CORBA Service cannot be stopped using the isstop command.
If this occurs, immediately execute the isstop command with —f specified.

Monitoring during Interstage Operation

Solaris OE

If Interstage is started using the isstart command and one of the Interstage services terminates
abnormally during operation, execute the following recovery processing:

e |If CORBA Service, Naming Service, Interface Repository, Load Balance, Component Transaction
Service, Database Linkage Service, WWW Server, HTML Page Editing Service, or Servlet Service
terminates abnormally, stop the Component Transaction Service, Database Linkage Service,
resource control program, WWW Server, HTML Page Editing Service, and Servlet Service.

e If the Event Service terminates abnormally, then Interstage continues operation. Even if the service
is stopped using an individual command (tdstop for Component Transaction Service), execute
recovery processing in the same manner as when the service terminates abnormally.
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Notes on the Database Linkage Service

Notes on OTS Command Execution

Windows

If an OTS command is executed in an environment in which the CORBA Service has not been installed,
an application error dialog box may be displayed.

In this case, install and start the CORBA Service and re-execute the otssetrsc command.

Notes on the Use of Oracle

Solaris OE

Use of Oracle Database by Java Server Application
Use Oracle 8.0.5 or later.

Using Oracle8

An error message is displayed at recovery and an unsolved transaction is left in both the following
scenarios:

— By ROLLBACK FORCE, forced rollback using manual rollback function of Oracle8 on the
unresolved function.

— Resource management program restarted. The output messages are shown below.
OTS: WARNING: 9666 System memory or system resource is insufficient.

The following message would be displayed if committed using the command “otspendlist.”
OTS: ERROR: 9348 Error occurred in commit operation.

Discharge in-doubt status by entering command “otspendlist”.

Installation of Oracle8i(8.1.6)

When Oracle8i(8.1.6) is used for distributed transaction linkage, the installation must be carefully
performed. Install the necessary functions for using the user application in process environment.
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Notes on Development using Functions for the Java Language
Provided by the Database Linkage Service of Interstage 1.1 or
Earlier

Solaris OE

Use environment under Database Linkage Service installation directory/pc/lib/J11.

Maximum Number of Resources for One Transaction

The maximum number of resources that can be used in a transaction using the isinit command is four.
This value cannot be changed.

Sample Provided with Database Linkage Service

Solaris OE

Use Pro*COBOL1.8.27 when you precompile the COBOL data base cooperation service sample
application. When Pro*COBOL R8.0.5 is used, the following line should be deleted from the COBOL
sample:

COPY SYMBOL-CONST IN CORBA

According to this, reserved words declared in the COBOL register and library
($OD_HOME/include/COBOL/CONST.cbl) cannot be used.

CORBA Server Application is Operated using Multi Thread

Solaris OE

If resource management program or OTS system is re-started under the CORBA server application
operation, do not call CORBA server application from client. Restart after start.
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Notes on InfoDirectory

This section provides additional information on InfoDirectory.

Setup Item Related to the Maximum Simultaneous Number of
Clients Connected

The following setting of InfoDirectory is needed when InfoDirectory is used by the security function of
the Component Transaction Service and the online reference function of the WWW server. The exact
setting is also dependent on the maximum simultaneous connection number of clients.

1)

2)

Number of IPC messages of InfoDirectory

Set the following value for the "Maximum number of messages for each IPC queue" of the directory
service property when the maximum simultaneous connection number of clients exceeds 40.
Maximum number of connected clients x 5

Maximum number of associations of DSA

Set the maximum simultaneous connection number to the maximum number of associations of
network parameters of the InfoDirectory control tool when the maximum simultaneous connection
number of clients exceeds 100.

Error Messages in the Event Log

1)

2)

"No DSA in this directory"

When creating a new DSA, this message is output to the event log. This is not a problem because
this message is output when confirming DSA status.

If this message is output when not creating a new DSA however, examine the operating
environment for problems. Call your Fujitsu support center if there is no problem in the operating
environment.

Other error messages

If an error is detected in the processing of InfoDirectory, an error message is output to the event log.
In such cases, confirm the contents of the error message and examine the operating environment
for problems. Call your Fujitsu support center if there is no problem in the operating environment.
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Notes on JDK/JRE

Notes on Java VM

The default JavavVM when using JDK/JRE1.3.1_06 and 1.4.1_01 in Interstage Java Server Package is
Fujitsu JavaVM (FJVM). This default is synonymous with specifying "-fym" in the java command option.

Notes on OutOfMemoryError Caused by a Permanent Area
Shortage
The Permanent area is one of heap areas used to manage objects (Java classes and methods) that are
permanently referenced by HostSpotVM (including FIVM), which is a JavaVM introduced to JDK/JRE
1.3 and later. For a Java application that uses many classes and methods, the size of the Permanent
area must be increased. Especially if an OutOfMemroyError occurs irrespective of how much the

maximum heap value (specified in -Xmx) is increased, a Permanent area shortage may be one of the
possible causes. The default size of the Permanent area is as follows:

e JDK1.3.1(HotSpot ClientVM): 32MB

e JDK1.3.1(FJVM, HotSpot ServerVM): 64MB

e JDKL1.4.1(HotSpot ClientVM): 64MB

e JDK1.4.1(FIVM, HotSpot ServerVM): 64MB

The size of the Permanent area can be specified using JavaVM option "-XX:MaxPermSize."
Example: Set the maximum size of the Permanent area to 128 MB:
-XX:MaxPermSize=128m

Notes on java.lang.Object.wait()

After JDK/JRE is installed, java.lang.Object.wait() may be released (spurious wakeups) without waiting
for a restart instruction (notification), interruption, or time-out. Therefore, make a program so that wait()
is used in a loop.

Reference: Notes on the return value of java.beans.PropertyDescriptor.getWriteMethod()
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Notes on the Return Value of
java.beans.PropertyDescriptor.getWriteMethod()

JDK/JRE 1.3.1_08 and 1.4.0_01 solved the problem "bean methods may not be obtained," which
caused by a problem in java.beans.Introspector.getBeaninfor(). The operation of the
java.beans.Introspector that may have produced different results on different JavaVMs (because the
order in which methods should return was not defined in the JavaBeans specifications) has been
corrected. Accordingly, for an application in which the parameter data type of the set***() method that
sets class properties does not match the data type of the return value of the get***() method that obtains
class properties, null will be returned as a return value from PropertyDescriptor.getWriteMethod(). For
this reason, make a program so that these data types match.

3-34



Notes on Portal Component

Notes on Portal Component

Notes on Contents Use

A homepage (Web page) or the individual contents (text, images, music, etc.) on the homepage are
copyrighted. Therefore, using these copyrighted materials may infringe the copyright. It is recommended
that the permission of the copyright owner is obtained before using the homepage or its contents.

Notes at Logon
When logging on to Portal component, IDs/passwords of common users are sent without being encoded.
To improve security, it is recommended that the SSL environment be set up by the WWW server.

For a detailed description of the setup method, refer to the manual for the WWW server to be used.

Notes on Portal Component Server Operating Mode

When opening the Portal component server to the Internet, a secure environment must be built. In such
cases, it is recommended that an environment that places the SecurityDirector on DMZ and Portal
component on IDC, and connects the access to Portal component via SecurityDirector is built.

Also, always register the Portal component server in the DNS (Domain Name System).
Notes
e DMZ (DeMilitarized Zone)
This is a segment that is separated from the Internet and IDC by a firewall.
e IDC (Internet Data Center)

This is a secure data center connected to the Internet.

Windows

Communicate between the Internet zone and DMZ (SecurityDirector) using HTTPS protocol. Only HTTP
and HTTPS protocols are valid between DMZ (SecurityDirector) and Portal component.

When opening the Portal component server to the Internet, use the procedure described below to
execute file access right commands. This prevents illegal file modification by Windows end users.

(1) Logon to the Windows server using the user ID that installed Portal component.
(2) Confirm that Portal component installation is completed.
(3) Open the command prompt.

The command prompt can be displayed by the following method:

Windows® 2000:

Start | Programs | Accessories | Command prompt

3-35



Chapter 3: Notes on Interstage Operation

Windows NT® 2000:
Start | Programs | Command prompt
(4) Execute the following program:
<Interstage install directory>\portalworks\bin\pwinetop.exe -d|-w
When this system is installed to "C:\Interstage\portalworks" on a machine belonging to the domain.
C:\Interstage\portalworks\bin\pwinetop.exe -d

When the system is installed to "C:\Interstage\portalworks" on a machine (work group machine)
that does not belong to the domain.

C:\Interstage\portalworks\bin\pwinetop.exe —w

(5) Change the permissions to the shared folder of Fujitsu Enabler.

Share folder name Directory

\\[Machine name]\enabler <Interstage install
directory>\Enabler\Server\control

\\[Machine name]\FAS$ADM <Interstage install
directory>\Enabler\Server\FASADM

Change the following permissions to the above-mentioned folder
Administrators group (full control).

Everyone (read only).

Solaris OE

e  Communicate between the Internet zone and DMZ (SecurityDirector) using HTTPS protocol. Only
HTTP and HTTPS protocols are valid between DMZ (SecurityDirector) and Portal component.

e  When Portal component is connected to a server on IDC using USP, set up a firewall between DMZ
and IDC to let only packets from the Portal component server be filtered out.

e  The recommended protocol to be filtered out through DMZ and IDC is HTTPS.

e When more than one Portal component is installed to share the repository data and directory
information with the database server and LDAP server, copy information required for Portal
component operations to the DMZ only, and hide the master data in IDC.
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Notes on USP Use

Notes on Web USP Use

1) Processing when "Network Error:503" Occurs

If "Network Error : 503" is displayed when a Web page was added as a private client, check that the
following are specified correctly:

e URL description
e [Bypass the proxy server for addresses beginning with] setting at Proxy server specification

If "Network error : 503" is generated even when the above processing is performed, the Web server
may have stopped.

2) Processing when "No response from service" Occurs

The message "No response from service. Processing interrupted by timeout." may be displayed in the
brick.

Check for the following probable causes:
e  The server power of the connection destination server is down, etc.

e  Some kind of problem occurred in the communication path up to the connection destination server

Notes on Web To Host USP(S2K USP) Use

1) Notes on Server2000 USP(S2K USP) Operation
The proxy logon function cannot be used in connection to Server2000 V1.1L40 and Server2000 1.1.

Also, the proxy logon function cannot be used when the Server2000 service name and screen name
contains Japanese language characters.

Notes when Applying Portal Component Independent
Authentication to Operation Management
The password can be changed using the command. The previous password is not required. However,

the command must be called on the server where the Portal component operation control is operating,
and the Servlet must be stopped.

Windows

Modification Method
Start the command prompt on the server that runs Portal component.
(1) Stop the [PortalServer] WorkUnit.
(2) Move to "<Interstage install folder>\portalworks\bin\"
(3) Input "pwadminpasschg.bat {new password}". "{" and "}" are unnecessary.

Example: "pwadminpasschg.bat pwadmin_password"
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(4) Startthe [PortalServer] WorkUnit.

(5) Start Portal component operation management and check the password change.

Solaris OE

Modification Method
(1) Stop the [PortalServer] WorkUnit.
(2) Move to "/opt/FISVispw/bin/"
(3) Input "pwadminpasschg.sh {new password}". "{" and "}" are unnecessary.
Example: "pwadminpasschg.sh pwadmin_password"
(4) Start the [PortalServer] WorkUnit.

(5) Start Porta component operation management and check the password change.

Notes on Using Operation Management Tool Commands

When each command of the operation management tool starts, a message that shows the start state
may be displayed. This message shows that the command is running normally. If command execution
generates an error, a report message is displayed. Check the error contents by means of this message.

Notes on Portal Component Repository Database Operation
The following precautions are necessary when starting and ending a database (Fujitsu Enabler or
Oracle) used as a Portal component repository.

(1) If the [PortalServer] WorkUnit was made automatic the starting service, Portal component start fails
depending on the start sequence with the database. In this case, restart the [PortalServer]
WorkUnit.

(2) If the database was stopped and restarted during Portal component operation, restart the
[PortalServer] WorkUnit.

About the Specification of Keep-alive between WebUSP and Back
Server
If HTTP communication between WebUSP and back server (or proxy, load distribution device) does not

use keep-alive, add “-Dhttp.keepAlive=false” to the [JavaVM option] by the Interstage Management
Console.

Notes when Using a Long Character String for Alias

If the message shown below was output at the user's window, the system may enter the URL not
handled state because the alias character name is long. Check the alias or scenario name.

The page cannot be found
HTTP 400 - Bad Request
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Notes on Using Administrative Console

Solaris OE

In the setting example of definition in the server that is displayed on the scenario registration
window or the USP addition window, Windows NT® server is used.

Example: file:/temp/scenario/scenario.jar
Make the actual settings in accordance with the syntax for the Solaris™ Operating Environment
system.

If only a host name is specified to start the Administrative console, an error may occur when the
operation control function is used because of the DNS settings.

Example: http://hostA/portalworks/PWAdmMinSystem

In such cases, specify FQDN as shown in the following example. In addition, when the URL is
specified for adding USP, be sure to specify FQDN.

Example: http://hostA.domain.com/portalworks/PWAdminSystem

Setting the Heap Size in the Java Execution Environment

It is recommended to set the heap size in the Java execution environment to 256 MB or more.

The procedure for changing the heap size is as follows:

@)
)
®3)

(4)

Start the Interstage Management Console.

Select [System], [WorkUnit], and then [PortalServer].

Add the following options to [JavaVM option]:

-XX:NewSize=64m, -XX:MaxNewSize=64m, -Xms256m, -Xmx256m
Restart [PortalServer] WorkUnit.

Select the [Operation] tab and restart [PortalServer].

Change the values for -XX:NewSize, -XX:MaxNewSize, -Xms, and -Xmx according to the environment
of the machine on which the Portal component is installed and the scope of using the Portal component.

-Xmsn

Specify the number of bytes for the initial size (n) of the memory allocation pool.

The value to be specified must be a multiple of 1024 that is greater than 2 megabytes.
To specify the value in kilobytes, suffix the value with character k or K.

To specify the value in megabytes, suffix the value with character m or M.

The default is 64 megabytes.

-Xmxn

Specify the number of bytes for the maximum size (n) of the memory allocation pool.

Specify the same value as the size specified for the -Xms option.

-XX:NewSize=64m, -XX:MaxNewSize=64m

When specifying 256 MB or more for the maximum size of the memory allocation pool, specify also
these three Java execution options.
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Notes on Framework

Security on the Internet

When using applications that use framework on the Internet, design them considering the security of
application development. Security may also be necessary depending on the firewall or other
infrastructure products.

Redistributable Files
The following files can be redistributed. These files can be distributed to the client environment and
used.
C:\Interstage\APC\redist\applet\ujiapplet.jar
C:\Interstage\APC\redist\ejb\ujiejbcl.jar
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